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Using the Resource Library
This tab includes resources to help you learn more about Cisco Unified Communications.

• Cisco Unified Communications System Description

• Cisco Unified Communications System Release Notes

• Network Topology Resources

• Ordering Guides

• Troubleshooting Individual Components

• Component Resources

• Configuration Command Files

• System Test Results

• Cisco Sales Demos

Cisco Unified Communications System Description

Cisco Unified Communications System Description (right-click to download PDF)

Cisco Unified Communications System Release Notes

System Release Notes for Contact Center: Cisco Unified Communications Release 5.0(2) 

System Release Notes for IP Telephony: Cisco Unified Communications Release 5.0(2) 

Network Topology Resources
This topic provides topology resources you can use to document network plans. Specifically, it includes:

• Microsoft Visio Contact Center Topology Diagrams as individual Microsoft Visio files

• How to Use Microsoft Visio Drawings Efficiently—Guidelines for best practices in using Microsoft 
Visio files
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Microsoft Visio Contact Center Topology Diagrams
You can download zip files containing Visio drawings of the logical and physical topologies for the 
contact center that are documented on the Prepare and Plan tab. Table 7-1 identifies the Visio drawings 
in each zip file.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at:

http://www.cisco.com/en/US/products/prod_visio_icon_list.html

Table 7-1 Microsoft Visio Logical and Physical Topology Diagrams

Description Filename

Zip file includes logical and physical 
drawings in Test Bed 1 as listed below

TestBed1_Topologies.zip (right-click to download zip) 
6.4 MB

Note If you click the link rather than right-click, the 
zip file may open in the secondary window but 
also replace the contents of this window. Use 
your Back button to return to this window.

Unified IP IVR Sites in Test Bed 1 Col_IPCC_CCM_Logical_ALL.vsd

Parent and Child Sites in Test Bed 1 Col_IPCC_CCM_Logical_P&C.vsd

Site 1 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site1.vsd

Site 2 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site2.vsd

Site 3 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site3.vsd

Site 4 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site4.vsd

Site 5 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site5.vsd

Site 6 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site6.vsd

Site 8 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site8.vsd

Site 9 IP IVR Logical Topology Col_IPCC_CCM_Logical_Site9.vsd

Site 1 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site1.vsd

Site 2 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site2.vsd

Site 3 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site3.vsd

Site 4 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site4.vsd

Site 5 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site5.vsd

Site 6 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site6.vsd

Site 8 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site8.vsd

Site 9 IP IVR Physical Topology Col_IPCC_CCM_Physical_Site9.vsd

Zip file includes logical and physical 
drawings in Test Bed 2 as listed below

TestBed2_Topologies.zip (right-click to download zip) 
7.4 MB

Note If you click the link rather than right-click, the 
zip file may open in the secondary window but 
also replace the contents of this window. Use 
your Back button to return to this window.

Unified CVP Sites in Test Bed 2 Col_IPCC_CVP_Logical_ALL.vsd
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How to Use Microsoft Visio Drawings Efficiently
Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word, 
PowerPoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can 
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the 
application data with the drawing. This object information is needed if you want to be able to 
double-click the drawing from Word or PowerPoint and have it open in Visio for editing. But pasting as 
an object adds many megabytes to the size of your file. With only a few such drawings, a Word document 
can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers and a trial 
for partners or customers to download. (They might even give up before it is done.) In addition, very 
large documents are more problem-prone.

Bringing a Visio Drawing into a Document

Unless you really need the live editing capability, avoid unnecessary file bloating by performing an extra 
step when you paste.

Step 1 In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

Step 2 At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special 
dialog box, choose Picture (Windows Metafile). 

Site 1 CVP Logical Topology Col_IPCC_CVP_Logical_Site1.vsd

Site 3 CVP Logical Topology Col_IPCC_CVP_Logical_Site3.vsd

Site 5 CVP Logical Topology Col_IPCC_CVP_Logical_Site5.vsd

Site 6 CVP Logical Topology Col_IPCC_CVP_Logical_Site6.vsd

Site 7 CVP Logical Topology Col_IPCC_CVP_Logical_Site7.vsd

Site 8 CVP Logical Topology Col_IPCC_CVP_Logical_Site8.vsd

Site 1 CVP Physical Topology Col_IPCC_CVP_Physical_Site1.vsd

Site 3 CVP Physical Topology Col_IPCC_CVP_Physical_Site3.vsd

Site 5 CVP Physical Topology Col_IPCC_CVP_Physical_Site5.vsd

Site 6 CVP Physical Topology Col_IPCC_CVP_Physical_Site6.vsd

Site 7 CVP Physical Topology Col_IPCC_CVP_Physical_Site7.vsd

Site 8 CVP Physical Topology Col_IPCC_CVP_Physical_Site8.vsd

Table 7-1 Microsoft Visio Logical and Physical Topology Diagrams (continued)

Description Filename
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Step 3 Click OK. The drawing pastes as an ordinary picture. If it is not positioned properly, choose Format > 
Picture, click the Layout tab and select In line with text. This is generally the most reliable layout 
option.

The Bottom Line

Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special. 

Downsizing Existing Drawings

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and, 
if so, fix the problem.

Step 1 With the drawing selected in the Word or PowerPoint document, choose Edit. At the bottom of the Edit 
menu, you will see one of the following:

• Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much 
more file space than it needs to. Go on to Step 2. 

• Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file 
size. 

Step 2 If the drawing is an object, cut it (Ctrl-X), and then repaste as in Bringing a Visio Drawing into a 
Document.

Tip You can easily click through the document to check each picture by using Word's handy Go To feature: 
Where you want to start searching, press Ctrl-G. In the Go To What list, select Graphic and click Next. 
You go to the next graphic. Click it to select and then check as in Step 1. If needed, repaste as in Step 2. 
Click Next and continue these steps for other graphics.
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Ordering Guides
Ordering guides for most Cisco Unified Communications products are available for partners and Cisco 
employees.

Software Bundles

• Unified Communications Solution Bundle

Call Control, End Points, and Call Control Applications

• Cisco Unified CallManager 5.0

• Cisco Unified IP Phones

• Cisco Emergency Responder (this will be available in a future release)

• Cisco Unified MobilityManager (this will be available in a future release)

• Cisco CallManager Express 

• Cisco Unified Survivable Remote Site Telephony (SRST) 

Contact Center 

• Cisco Customer Contact Center Business Unit Price List  (right-click to download PDF)

This list addresses pricing and packaging structure for all Contact Center products.

Conferencing

• Cisco Unified MeetingPlace (right-click to download PDF)

• Cisco Unified MeetingPlace Express  (right-click to download PDF)

Messaging

• Cisco Unity  (right-click to download PDF)

• Cisco Unity Connection  (right-click to download PDF)

Network Management

• Operations Manager (this will be available in a future release)

• Service Monitor (this will be available in a future release)

Troubleshooting Individual Components
For a list of the diagnostic tools and supporting troubleshooting documentation available for most 
components in a contact center network, see Contact Center Component Troubleshooting Tools and 
Documentation on the Implement tab.

Component Resources
The following list provides links to the main page for documentation on various Cisco Unified 
Communications components, from which you can navigate to individual documents. For documentation 
on specific tasks, see the relevant topic, such as Component Installation and Configuration Guides on 
the Implement tab.
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Cisco Unified Communications

http://www.cisco.com/go/unified-techinfo

Links to this Technical Information Site and the Technical Information Site for IP telephony.

Voice Documentation

http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Main page for documentation on all Cisco voice products.

Cisco Unified CallManager

http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

Cisco Unified IP Phone

http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Cisco Unified Intelligent Contact Management/Unified Contact Center Enterprise Edition

http://www.cisco.com/en/US/products/sw/custcosw/ps1001/tsd_products_support_series_home.html

Cisco Unified Contact Center Enterprise

http://www.cisco.com/en/US/products/sw/custcosw/ps1844/tsd_products_support_series_home.html

Cisco Unified Operations Manager

http://www.cisco.com/en/US/products/ps6535/tsd_products_support_series_home.html

Cisco Unity Connection

http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

Customer Response Solutions

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html

Cisco Unified Customer Voice Portal

http://www.cisco.com/en/US/products/sw/custcosw/ps1006/tsd_products_support_series_home.html

Cisco Telephony Integration Object Server

http://www.cisco.com/en/US/products/sw/custcosw/ps14/tsd_products_support_series_home.html

Cisco Agent Desktop

http://www.cisco.com/en/US/products/sw/custcosw/ps427/tsd_products_support_series_home.html

Cisco Security Agents

http://www.cisco.com/en/US/products/sw/secursw/ps5057/tsd_products_support_series_home.html

CiscoWorks Management Center for Cisco Security Agents

http://www.cisco.com/en/US/products/sw/cscowork/ps5212/tsd_products_support_series_home.html

Cisco Catalyst 3550 Series Switches

http://www.cisco.com/en/US/products/hw/switches/ps646/tsd_products_support_series_home.html
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Cisco Catalyst 6500 Series Switches Install and Upgrade Guides

http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html

Cisco CSS 11000 Series Content Services Switches

http://www.cisco.com/en/US/products/hw/contnetw/ps789/tsd_products_support_eol_series_home.ht
ml

Cisco 7800 Series Media Convergence Servers Guides

http://www.cisco.com/en/US/products/hw/voiceapp/ps378/tsd_products_support_series_home.html

Cisco AS5400 Series Universal Gateways

http://www.cisco.com/en/US/products/hw/univgate/ps505/tsd_products_support_series_home.html

Cisco AS5800 Series Universal Gateways

http://www.cisco.com/en/US/products/hw/univgate/ps509/tsd_products_support_series_home.html

Cisco 3600 Series Multiservice Platforms

http://www.cisco.com/en/US/products/hw/routers/ps274/tsd_products_support_series_home.html

Cisco 3700 Series Multiservice Access Routers

http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html

Cisco 3800 Series Integrated Services Routers

http://www.cisco.com/en/US/products/ps5855/tsd_products_support_series_home.html

Cisco IOS Software Release 12.4 T

http://www.cisco.com/en/US/products/ps6350/tsd_products_support_series_home.html

Configuration Command Files
You can download sample configuration files for the call flow components described in Tested Call 
Flows.

Table 7-2 Sample Call Flow Component Configuration Files

Description Filename

Test Bed 1 Call Flows: Cisco Unified CallManager 
Post-Routed Call Flow Components 

TestBed1_Config.zip (right-click to 
download zip) includes the files below.

Note If you click the link rather than 
right-click, the zip file may open in 
the secondary window but also 
replace the contents of this window. 
Use your Back button to return to 
this window.

Site1 Cisco 3660 Gatekeeper1 cs1-3660-gk1-config

Site1 Cisco 3660 Gatekeeper2 cs1-3660-gk2-config

Site1 Cisco 3660 Gatekeeper3 cs1-3660-gk3-config
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Site1 Cisco 3745 Gateway1 cs1-3745-gw1-config

Site1 Cisco CMM Gateway1 cs1-cmm-gw1-config

Site2 Cisco 3825 Gateway1  cs2-3825-gw1-config

Site3 Cisco 3725 Gateway1 cs3-3725-gw1-config

Site4 Cisco 3660 Gatekeeper1 cs4-3660-gk1-config

Site4 Cisco 3660 Gatekeeper2 cs4-3660-gk2-config

Site4 Cisco 3660 Gatekeeper3 cs4-3660-gk3-config

Site4 Cisco 3745 Gateway1 cs4-3745-gw1-config

Site4 Cisco 5850 Gateway1  cs4-5850-gw1-config

Site5 Cisco CMM Gateway1 cs5-cmm-gw1-config

Site6 Cisco 3745 Gateway1 cs6-3745-gw1-config 

Site6 Cisco 3745 Gateway2 cs6-3745-gw2-config 

Site9 Cisco 3660 Gatekeeper1 cs9-3660-gk1-config

Site9 Cisco CMM Gateway1 cs9-cmm-gw1-config

Test Bed 2 Call Flows: Cisco Unified Customer Voice 
Portal Post-Routed Call Flow Components 

TestBed2_Config.zip (right-click to 
download zip) includes the files below.

Note If you click the link rather than 
right-click, the zip file may open in 
the secondary window but also 
replace the contents of this window. 
Use your Back button to return to 
this window.

Site1 Cisco 3660 Gatekeeper1  ps1-3660-gk1-config 

Site1 Cisco 3660 Gatekeeper2  ps1-3660-gk2-config

Site1 Cisco 3745 Gateway1   ps1-3745-gw1-config 

Site1 Cisco 6509 MSFC Switch  ps1-6509-msfc-config

Site1 Cisco 6509 Switch1   ps1-6509-SW1-config

Site1 Cisco 7206VXR Router   ps1-7206-config

Site1 Cisco Content Services Switch1 ps1-css1-config

Site3 Cisco 3825 Gateway1 ps3-3825-gw1-config

Site3 Cisco 3825 Gateway2 ps3-3825-gw2-config

Site3 Cisco AS5400HPX Gateway1 ps3-5400-gw1-config

Site3 Cisco AS5400HPX Gateway2 ps3-5400-gw2-config

Site3 Cisco 6506 MSFC Switch ps3-6506-msfc-config

Site3 Cisco 6506 Switch1 ps3-6506-SW1-config

Site3 Cisco 7206VXR Router ps3-7206-config

Site5 Cisco 3660 Gatekeeper1 ps5-3660-gk1-config 

Site5 Cisco 3660 Gatekeeper2 ps5-3660-gk2-config

Table 7-2 Sample Call Flow Component Configuration Files (continued)

Description Filename
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System Test Results
This topic summarizes the results of Cisco Unified Communications Release 5.0(2) system testing for 
contact center environments. This topic contains the following sections:

• Testing Objectives

• Tested Deployment Models and Sites

• Test Results

Testing Objectives
Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring, 
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of 
system testing is to validate the seamless interoperability and stability of the components that make up 
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

• Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the 
system level and usability for system components 

• End-to-End Functionality Testing—To verify the end-to-end functionality of system components

• Basic Functionality and Feature Testing—To verify basic call flows and component features

• Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based 
on TAC input

• Interoperability Testing—To verify the interoperability among system components

• Scalability Testing—To verify system functionality during scalability tests

Site5 Cisco 3745 Gateway1 ps5-3745-gw1-config 

Site5 Cisco 6509 MSFC Switch ps5-6509-msfc-config

Site5 Cisco 6509 Switch1 ps5-6509-SW1-config

Site5 Cisco 7206VXR Router ps5-7206-config

Site5 Cisco Content Services Switch2 ps5-css2-config

Site6 Cisco 3725 Gateway1 ps6-3725-gw1-config 

Site6 Cisco 3725 Gateway2 ps6-3725-gw2-config

Site6 Cisco 3745 Gateway1 ps6-3745-gw1-config

Site6 Cisco AS5400HPX Gateway1 ps6-5400-gw1-config

Site6 Cisco AS5400HPX Gateway2 ps6-5400-gw2-config

Site6 Cisco AS5400HPX Gateway3 ps6-5400-gw3-config

Site6 Cisco AS5400HPX Gateway4 ps6-5400-gw4-config

Site6 Cisco AS5400HPX Gateway5 ps6-5400-gw5-config

Site6 Cisco AS5400HPX Gateway6 ps6-5400-gw6-config

Table 7-2 Sample Call Flow Component Configuration Files (continued)

Description Filename
7-9
Cisco Unified Communications System for Contact Center Release 5.0(2)

 



 

Chapter 7      Resource Library
  Cisco Sales Demos
• Performance, Load, and Stress Testing—To verify system functionality during performance, load, 
and stress tests

• Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and 
recovery, and behavior in redundant configurations

Tested Deployment Models and Sites
The System Test Architecture Reference Manual provides information about the components and 
configurations that have been tested and verified as part of a given Cisco Unified Communications 
release. For information about the components, configurations, and environment tested in Cisco Unified 
Communications Release 5.0(2), see Test Deployment Models and Sites.

Test Results
The results of the system tests performed for contact center during Cisco Unified Communications 
Release 5.0(2) are shown in the System Test Results.

The test results contain the following information:

• Title—Title of the test.

• ID—Identifier for the test.

• Description—Description of the purpose of the test.

• Features Tested—Component feature tested.

• Status—Result of the test and any defects related to the test case. Possible values are:

– Passed—Test case passed as described in the table.

– Failed—Test case failed and the reason is described in the listed defect.

– Passed with exception—Test case as described passed but an anomaly occurred that was not 
directly related to the functionality being tested. Possible anomalies are as follows: 

The test steps were modified based on the actual feature implementation.

The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as 
required. 

• Defects—Identifier for any defect that was opened against the test. If you have an account with 
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:

http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl

Cisco Sales Demos
The Cisco Sales Demo document describes the various methods that are available for use by Cisco sales 
teams to demonstrate the Cisco Unified Communications system.

Cisco Unified Communications System Demonstration Programs  
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